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Note 
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to provide a single source for writing academic papers at W.T. Woodson High School.  The 

Instructional Council has designated this manual as the standard by which all academic papers 

should be formatted.   

Since we recognize that college and the world outside of school will have a variety of 

requirements for technical writing, we encourage students to learn how to read this document as a 

style manual, for that skill will allow them to be successful meeting the standards for American 

Psychological Association, Modern Language Association, Chicago, or any of the other style 

manuals required by colleges and universities.   
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Part I:  Format of the Academic Paper 

 

Note:  See Appendices A and B for instructions on changing margins in Word 2003 and 

Word 2007. 

 

1.1   Paper and typeface 

 Use only 8 1/2 –by-11 inch paper. 

 Choose Arial or Times New Roman 12-point font. 

 Print on one side of the paper in black ink. 

 Always keep an electronic copy of your paper. 

 

1.2  Margins and Spacing 

Set your margins at 1” at the top, bottom, and sides of the paper.  Note:  Microsoft Word 

2003 has side margins set automatically at 1.25”.  These must be changed.   

 

Paragraphs are indicated by indenting ½”.   Hit TAB one time to indent a paragraph.  Do not 

put additional spacing between paragraphs. 
 

The body of the paper is left-justified, not center- or fully-justified. 

 

 All parts of your essay must be double-spaced.  See Appendices A and B for instructions on 

changing spacing. 

 

The Works Cited or Bibliography pages must be single-spaced with double-spacing between 

entries. 

 

1.3  Heading, Header, and Title 

 

Your paper does not have a title page.  Instead, create a heading beginning 1” from the top 

of the first page next to the left margin.  Be sure to include your name, your teacher‟s name 

and period, and the date you submit the paper. 

 

Page numbers are ½” from the top of the paper.  They are right-justified in the “Header.”  

Your last name and the page number must be on each page of the paper.  See Appendices 

A & B for instructions on formatting the header. 

 

The title of the paper is centered just below the heading in regular font.  Please note:  Do 

not make the title a bigger font!  Do not underline or italicize the title. 

 

Back to top
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1.4   Example of the first page 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1.5   Long Quotations  

 

A long prose quotation (more than four lines) requires special formatting.  Indent 1” from the left 

margin and type the quotation single-spaced, preceded by a colon, and without quotation marks. 

 

EXAMPLE (Gibaldi): 

 

 

1.6 Data Analysis 

 

1.6.1 Tables and Charts 

 Each data table should have a title which states the independent variable and 

dependent variable. 

 Each column in the data table should reflect the variable that you are measuring along 

with its unit, in the form of “variable (unit).”  

1” 

At the conclusion of Lord of the Flies, Ralph and the other boys realize the 

horror of their actions: 

The tears began to flow and sobs shook him.  He gave himself up to 

them now for the first time on the island; great, shuddering spasms of 

grief that seems to wrench his whole body.  His voice rose under the 

black smoke before the burning wreckage of the island; and infected 

by that emotion, the other little boys began to shake and sob too (186). 

 

Jack‟s relief is obvious.  Though at the beginning of the book he was thrilled 

to consider the possibilities of life without adults, by this time, he thoroughly 

 

 

Smith 1 

 

 

John Smith 

 

Ms. Jones 

 

Period 4 

 

3 September 2008 

 

Spinal Tuberculosis 

 

 Today tuberculosis is a disease that is easily identified and cured, but for 

centuries the death sentence brought by a diagnosis of tuberculosis became an                                                                                                                                                                                                                                                               

 

½” 

1” 

1” 

Indent ½” 

Double -
space 

1” 
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 There might be slight variations in the format based on the area of science. 

 General Format: 

o Should be done on a computer. If not, a ruler must be used. 

o Gridlines must be included 

o All data should be centered in the cell, both horizontally and vertically 

 See your teacher for specific formatting requirements for your curriculum. 

 

1.6.2 Graphs 

 Title must be descriptive and include the variables you measured.  

 Axes must be labeled with the variable recorded and the unit, in the form of “variable 

(unit).”  

 General Format: 

o Should be done on a computer. If not, a ruler must be used. 

o The axes should be divided into an appropriate scale based on what you are 

measuring. Axes should typically start at zero.  

o If you are representing multiple data sets on one graph, include a legend.  

o If using a scatter plot, a trend line is generally used. In that case, do not include a 

line that connects the dots. 

 See your teacher for specific formatting requirements for your curriculum. 

 

1.6.3 Data Calculations 

 When a calculation is required as part of the analysis, a sample calculation needs to 

be shown.  

 If doing a statistical analysis, include type of statistical test that was used and the 

probability value. Calculations do not necessarily need to be shown.  

 

1.6.4 Analysis Statement 

 This is a description of the trend in your data. This does not offer any explanation. 

 You may include a statement as to whether you accept or reject your research 

hypothesis. You should never say that you prove or disprove your hypothesis.  

 

1.6.5 Other  

 Biology: When discussing a living organism, use the scientific name. It should be 

italicized. “Genus” should start with a capital letter and “species” with a lower case 

letter. 

 “Effect” is a noun, and “affect” is a verb. 

 Ensure you are using the correct plural form of a word, such as “bacteria” (plural of 

“bacterium”) and “analyses” (plural of “analysis”). 

 When writing numbers in scientific notation, it should be done correctly. 1.6x10^-19 

C is not correct, but 1.6×10
-19

 C is. See Appendix D (32) for instructions on how to 

format scientific notation. 

 Variables should always be italicized. Vectors should be boldfaced and not italicized.  

 If time is one of your variables, it should be on the x-axis.  

 If a variable is represented by a Greek letter, use the actual Greek letter rather than 

the English term or writing it out. For example, show “Ω” rather than writing 

“omega.”  See Appendix C (31) for instructions on including symbols. 

 

1.7  Pictures:  See your teacher for information about formatting pictures. 
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Part II:  Research Component 

2.1  Plagiarism 

 

2.1.1  Definition of Plagiarism 

Most academic writing requires students to read and assimilate information from a variety of 

sources.  These sources must be acknowledged and referenced or plagiarism occurs. 

 

According to Dictionary.com, plagiarism is “the unauthorized use or close imitation of the 

language and thoughts of another author and the representation of them as one‟s own original 

work.”   To avoid plagiarism, students must submit with each researched academic paper a Works 

Cited or Bibliography page, and they must provide internal documentation to credit the authors 

whose ideas they use. 

 

Further, simply providing internal documentation is insufficient for an exact copy of an author‟s 

words.  You must use quotations marks to set-off word-for-word reproductions.  Internal 

documentation means you have used the author‟s ideas; quotation marks mean you have used his 

words. 

 

Plagiarism.org provides details on what constitutes plagiarism.  It cites all of the following as 

examples of plagiarism (emphasis added): 

 Turning in someone else‟s work as your own. 

 Copying words or ideas from someone else without giving credit. 

 Failing to put a quotation in quotation marks. 

 Giving incorrect information about the source of a quotation. 

 Changing words but copying the sentence structure of a source without giving 

credit. 

 Copying so many words or ideas from a source that it makes up the majority of 

your work whether you give credit or not. (“What is Plagiarism?”)  

 

Remember, too, that  all sources used in your paper must be cited.  For example, if you interview 

an expert in the field of genetic engineering, that interview must appear on your Bibliography or 

Works Cited page, and internal documentation must follow all references to the information you 

received during that interview. 

 

2.1.2  When documentation is not required 

Documentation is not required when 

 using a familiar proverb or saying (“A stitch in time saves nine”). 

 repeating a well-known quotation (“I have a dream”). 

 referring to common knowledge (“The Declaration of Independence was signed on July 

4, 1776”). 

 

However, when in doubt, cite your source. 

 

2.1.3 Other Concerns 

Reusing a research paper from one course in another is cheating.  If you would like to do more 

research on a topic you have used before, be sure to check with your teacher. 
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Teachers sometimes assign students to work on projects in small groups; then you will put the 

names of all participants on the paper you submit.  Any project that is assigned as an individual 

project (research paper, homework assignment, etc.) must be completed by each student 

separately.  Using another‟s paper as a source for your own is also cheating. 

 

2.1.4  Ways to avoid plagiarism 

Gibaldi recommends several ways to avoid plagiarism: 

 Be sure to consider your paper as you complete the research for it. 

 Take notes marking word-for-word reproductions in quotation marks. 

 Never copy and paste text from an internet source directly into your paper. 

 Identify the sources for all the information you take from others. 

 Ask your teacher if you have any questions about sources and citations.  

 

2.1.5 Consequences of plagiarism 
In the real world, the consequences of plagiarism are very serious.  People lose their reputations 

and careers when they plagiarize the ideas, stories, or style of others.  In addition, legal 

consequences can ensue including significant monetary damages if the plagiarism results in 

damages to the source or original author. 

 

Woodson takes plagiarism very seriously, and teachers use many tools including Turnitin.com to 

identify cheating.  The Woodson documents that you sign at the beginning of the year set out the 

consequences.  When teachers discover instances of plagiarism in major or minor assignments, 

they call your home, write referrals to the Honor Council, and assign grades of zero for the 

projects.  Administrative consequences increase with each referral. 

 

Back to top
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2.1.6  Fairfax County Explanation and Policy on Plagiarism 

 

The Fairfax County Public Schools‟ high school guide to Grading and Reporting to Parents states: 

 

Cheating and plagiarizing are unacceptable behaviors that have moral and legal 

implications. 

 

Cheating is violating established rules and codes of ethics. Plagiarizing is falsely 

claiming authorship. Cheating and plagiarizing are serious offenses. 

 

I. Guidelines 

A. Teachers have the responsibility to: 

1. Teach or review the correct use of sources and citations when 

assigning work. 

2. Structure conditions during testing to alleviate the possibility of 

cheating. 

3. Specify the types of collaboration that are discouraged and those 

that are encouraged. 

B. Students have the responsibility to: 

1. Avoid situations that might contribute to cheating or plagiarizing. 

2. Avoid unauthorized assistance. 

3. Use sources in the prescribed manner. 

4. Document borrowed materials by citing sources. 

5. Avoid plagiarism by using quotation marks for statements taken 

from others, by acknowledging information and ideas borrowed 

from any source, and by consulting faculty members about 

questionable situation. 

6. Avoid “cutting” and “pasting” from computer text without proper 

attribution. 

II. Implications 

Students who violate “the spirit or the letter of the law” as regards cheating and 

plagiarizing must accept responsibility for their actions and the accompanying 

consequences. Consequences may include: 

A. A parent-student-administrator conference. 

B. A lowering of the grade or receiving an F for the assignment. 

C. An alternative assignment or recompletion of the original assignment. 

(19) 

 

 

Back to top
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2.2  Works Cited pages and Parenthetical Documentation 

 

2.2.1  Definitions of Terms 

A Works Cited list contains all the sources you used in the text of your paper.  It differs from a 

Bibliography which contains all the books you consulted.  Use of a Works Cited page allows the 

writer to include all sources including nonprint sources such as films and radio programs which 

would not be a part of a Bibliography.  Ask your teacher which s/he expects; you will never need 

both. 

 

Parenthetical (or “internal”) documentation refers to the citations within the text of the paper 

that refer the reader to the Works Cited or Bibliography page to find more information about the 

source of the information, ideas, or quotations in the text.  Since you want the reader to find the 

information easily, you will be as specific as possible, using page or paragraph numbers when 

available. 

 

An Annotated Bibliography contains sources on a particular topic with your comments about the 

sources‟ effectiveness and usefulness. 

 

2.2.3  How to prepare a Works Cited or Bibliography 

Once you believe you have completed your research, create a rough draft of your Works Cited or 

Bibliography.  You will need this for the internal documentation in your paper.  You will also keep 

track of which sources you use for your information, so you will accurately list them on the final 

copy of the page.   

 

While writing your paper, you may discover that you need more information.  If so, find additional 

sources, and add the information to the Works Cited/Bibliography draft. 

 

Remember these general requirements for the Works Cited/Bibliography page: 

 Start a new page that will eventually appear at the end of your paper. 

 Number it sequentially from the last page of the paper itself.  The header, as on the 

other pages, will include your last name and the page number on the right margin, ½” 

from the top of the page.  This will continue the numbering in your paper. 

 Single-space the page. 

 Center the title “Works Cited” or “Bibliography” 1”from the top of the page.  Do not 

use the quotation marks. 

 The first line of the entry is on the left margin.  All additional lines are indented ½” 

from the left margin.  This format is called “hanging indent.” 

 Make the space between the entries double-space. (See page 25 for an example.) 

 Put the entries in alphabetical order ignoring any article (“a,” “an,” or “the”) that comes 

at the beginning. 

 

Back to top
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2.2.4  Formatting the Parenthetical Documentation 

Woodson requires parenthetical (or internal) documentation.  This allows the reader to know 

quickly where the writer of the paper found his/her information.  It always refers back to the 

Works Cited or Bibliography page, and so the format of the documentation is based on the 

entries:  e.g. if the words are italicized on the Works Cited page, they will be italicized in 

the parenthetical documentation.  See the samples in the boxes below. 

 

As a rule, you will use first word in the citation.  The word will refer the reader to the 

correct source.  If the source is Print and has page numbers, you will also include the page 

number where you found the quotation, fact, statistic, or other information.   

 

If the Works Cited or Bibliography page contains two or more entries that begin with the 

same word(s), you will copy the first and all following words until you have one that is 

different.  Be sure to start with the first word, though, so the reader is able to find your 

source! 
 

The documentation immediately follows the quotation or fact cited, but the parentheses stay 

within the sentence; consequently, the period is outside the parentheses as in this example 

from a research paper by Diana Mihalache referring to this entry on the Works Cited page: 

 

Ellis, Peter Berresford.  Celtic Women:  Women in Celtic Society and Literature.  Grand Rapids:  

William B. Eerdmans Publishing Company, 1995. Print. 

 

 

  
 

NOTES on example:   
  

The words “[from the same tribe]” are in brackets because the writer has added them as 

explanation to the original quotation from the Ellis text. 

 

The second parenthetical reference does not require the author‟s name since it is from the 

same source as the previous citation.  Although it is not quoted directly (e.g. with quotation 

marks word-for-word from the book), this information still requires a reference since the 

facts were available only through this source. 

 

Back to top

At these meetings the “sexes [from the same tribe] were not seated separately but 

as clans” (Ellis 106). This further strengthened women‟s power in the society. 

Aside from being landowners and political leaders, women could also become 

poets, priestesses, and teachers (170). 
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2.3  Specific Works Cited/Bibliography Entries and Parenthetic References 

Generally the entries on the Works Cited/Bibliography page will include author‟s name, title 

of the article and/or book, and publication information.  The sections below give more 

specifics about formatting the entries from different types of sources. 

 

Be sure to follow all instruction including italicizing, punctuation (colons, periods, commas, 

quotation marks), and spacing.  In academic papers, all the details are important!  

 

Alphabetize anonymous sources by the first letter of the title ignoring “a,” “an,” or 

“the.” 

 

Note:  All examples are from the sources in the guide‟s Works Cited. 

 

Guide to Works Cited/Parenthetical References 

2.3.1 Book: Single Author 12 
2.3.2 Book: Multiple Authors 12 

2.3.3 Book: Textbook 13 
2.3.4 Book:  Anthology 13 

2.3.5 Book: Corporate Author 14 

2.3.6 Book: Work in Anthology (also translations) 14 
2.3.7 Book: Article in Reference Book 15 

2.3.8 Book:  Anonymous 15 
2.3.9 E-Book (from database) 16 

2.3.10 E-Book (from website) 16 

2.3.11 Article: Reference Book 17 
2.3.12 Article:  Journal 17 

2.3.13 Article: Magazine 17 

2.3.14 Article:  Journal from a Database 18 

2.3.15 Article: Magazine from a Database 18 

2.3.16 Article: Database (NOT magazine/news/journal) 19 
2.3.17 Article: Newspaper 19 

2.3.18 Article: Newspaper from Database 20 

2.3.19 Internet:  Website (page from a website) 20 
2.3.20 Internet:  Website (entire website) 21 

2.3.21 Internet:  Journal Article 21 
2.3.22 Internet:  Magazine Article 21 

2.3.23 Internet:  Newspaper Article 22 

2.3.24 Internet:  Image from a Website  22 
2.3.25 Image from a Database 23 

2.3.26 Image from a Book 23 

2.3.27 Sound Recording 25 
2.3.28 Sound Recording from the Internet 25 

2.3.29 Sound Recording from a Database 25 
2.3.30 Video Clip from a Database 25 

2.3.31 Video Clip Online (YouTube and other websites) 26 

2.3.32 Personal Interview 26 
2.3.33 Oral Presentations (e.g. Speeches, Lectures) 27 

2.3.34 Blog:  Entire Blog 27 
2.3.35 Blog:  Entry or Comment 28 

2.3.36 E-mail 28 

Sample Works Cited Page 29 
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NOTE:  Because a book on an eReader is first and foremost a book, when using an eReader, 

complete the citation exactly as shown in the appropriate sample, but instead of the format listed 

(e.g. Print or Web), write the name of the eReader and the word Edition  (e.g. Kindle Edition or 

Nook Edition). 

 

Example: 

Collins, Suzanne.  The Hunger Games.  New York: Scholastic Paperbacks, 2009.  Kindle Edition. 

 

 

2.3.1  Book: Single Author 

Work Cited: 

Author‟s Last Name, First Name.  Title of Book.  Publication city: Publisher‟s Name, 

Publication year. Print. 

 

Example:   

Fukuyama, Francis.  Our Posthuman Future: Consequences of the Biotechnology 

Revolution. New York: Farrar, 2002.  Print. 

 

Parenthetical Reference: 

(First-word-in-citation page) 

 

Example: 

(Fukuyama 36) 

 

 

2.3.2  Book: Multiple Authors 

Work Cited: 

Author‟s Last Name, First Name, and Second Author‟s First Name Last Name.  Title of 

Book.  Publication city: Publisher‟s Name, Publication year. Print. 

 

Example:   

Eggins, Suzanne, and Diane Slade.  Analyzing Casual Conversation. London: Cassell, 

1997.  Print. 

 

 

Parenthetical Reference: 

(Authors‟ Last Names page) 

 

Example: 

(Eggins and Slade 146) 

 

Back to top
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2.3.3 Book:  Textbook 

Work Cited: 

Author‟s Last Name, First Name.  Title of Book.   Publication city: Publisher‟s Name, 

Publication year. Print. 

 

NOTE:  If a book has more than 4 authors, just list the first and then add “et al.” 

Example:   

Beck, Roger, et al.  World History: Patterns of Interaction.  Evanston, IL: McDougal 

Littell, 2005.  Print. 

 

Parenthetical Reference: 

(First-word-in-citation page) 

 

Example: 

 (Beck 545) 

 

 

2.3.4 Book:  Anthology 

Work Cited: 

Editor‟s Last Name, First Name, ed.  Title of Book.   Publication city: Publisher‟s Name, 

Publication year.  Print. 

 

Example:   

Lopate, Philllip, ed.  The Art of the Personal Essay: An Anthology from the Classical Era 

to the Present.  New York: Anchor-Doubleday, 1994.  Print. 

 

Parenthetical Reference: 

(Editor‟s Last Name page) 

 

Example: 

 (Lopate 36) 

 

Back to top
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2.3.5  Book: Corporate Author 

Work Cited: 

Group name.  Title of Book.  Ed. Editor First Name Last Name.  Publication city: 

Publisher‟s Name, Publication year. Print. 
 

Examples: 

With Editor:   

American Medical Association.  The American Medical Association Encyclopedia of 

Medicine.  Ed. Charles B. Clayman.  New York: Random, 1989.  Print. 
 

Without Editor: 

National Research Council.  Beyond Six Billion: Forecasting the World’s Population.  

Washington: National Academy, 2000.  Print. 

 

Parenthetical Reference: 

(Corporation page) 
 

Examples:  

 (American Medical Association 36) 

(National Research Council 12) 
 

 

2.3.6  Book: Work in Anthology 

Work Cited: 

Author Last Name, First name.  “Title of Work.” Trans. Translator‟s Name.  Title of Book.  

Ed. Editor‟s Name. Publication city: Publisher‟s Name, Publication year.  Page 

numbers.  Print. 
 

[NOTE:  Use the translator’s name only when necessary,] 

Examples:   

Allende, Isabel.  “Toad‟s Mouth.”  Trans. Margaret Sayers Peden.  A Hammock beneath 

the Mangoes: Stories from Latin America.  Ed. Thomas Colchie.  New York: 

Plume, 1992. 83-88. Print. 
 

Franco, Veronica.  “To the Painter Jacopo Tintoretto.”  Poems and Selected Letters. Eds. 

and trans. Ann Rosalind Jones and Margaret F. Rosenthal.  Chicago: University of 

Chicago Press, 1998. 35-37.  Print. 
 

 

Parenthetical Reference: 

(First-word-in-citation page) 
 

Examples: 

(Allende 84) 

(Franco 35) 

 

 

Back to top
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2.3.7  Book: Article in Reference Book 

Work Cited: 

Author Name if given.  “Article Title.”  Title of Book.  Editor‟ Name if given.  Edition 

number.  Vol. #.  Publication city: Publisher‟s Name, Publication year.  Page #s. 

Print. 

 

Examples: 

Hanagan, Michael P.  “Labor History:   Strikes and Unions.” Encyclopedia of European 

Social History From 1350-2000.  Ed. Peter N. Stearns.  Vol. 3.  Detroit: Charles 

Scribner‟s Sons, 2001.  253-266.  Print. 

 

“Mandarin.”  The Encyclopedia Americana. 1994 ed. Print. 

[NOTE:  This source has no author or editor listed and is a common reference tool, so 

no publication information is needed.] 

 
 

Parenthetical Reference: 

(First-word-in-citation page) 

 

Examples: 

 (Hanagan 256)  

(“Mandarin” 162) 

 

 

2.3.8  Book:  Anonymous 

Alphabetize anonymous sources by the first letter of the title ignoring “a,” “an,” or 

“the.” 

Work Cited: 

Title of Book.  Publication city: Publisher‟s Name, Publication year.  Print. 

Examples: 

Encyclopedia of Virginia.  New York: Somerset, 1993.  Print. 

The Holy Bible: New International Version.  Grand Rapids: Zondervan, 1984.  Print. 

 

Parenthetical Reference: 

(Word-alphabetized page) 

 

Examples:  

(Encyclopedia 36) 

(Holy Bible 687) 

 

Back to top
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2.3.9 E-Book  (print book available through a database) 

Work Cited:   

Last Name, First Name (if available). “Article Title.”  Title of Book. Ed. Editor(s) Name. 

Edition.Volume. Place of Publication: Publisher, Date. Page Numbers. Database 

Name.  Database.  Date Accessed. 

 

Example: 

Hurd, Amy R. "Board Games." Encyclopedia of Recreation and Leisure in America. Ed. 

Gary  S. Cross. Vol. 1. Detroit: Charles Scribner's Sons, 2004. 108-112. Gale 

Virtual Reference Library. Database. 9 Sep. 2009. 

 

Parenthetical Reference: 

(Word-alphabetized page) 

 

Example: 

(Hurd 111) 

 

 

2.3.10 E-Book (from a website) 

Work Cited: 

Last Name, First Name. Title of Book. Place of Publication: Publisher, Publication Date. 

Title of Website. Web. Date Accessed. <URL>. 

Shorten the URL for websites by stopping at the first slash. 

Example: 

Bonnet, Bob and Dan Keen. 46 Science Fair Projects for the Evil Genius. New York: 

McGraw-Hill, 2009. Google Books. Web. 28 Sep. 2009.  

<http://books.google.com>.  

 

Parenthetical Reference: 

(First-word-in-citation [or two authors‟ names] page) 

 

Example: 

(Bonnet and Keen 3) 

 

 

Back to top
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2.3.11 Article: Reference Book  

Work Cited:   

Author Last Name, First Name. “Article Title.”  Title of Book.  Editor‟s Name. Place of 

Publication: Publisher, Publication Date.  Page Numbers.  Print. 

 

Example: 

Burbank, Rex J. and Jack B. Moore. “America During the Period of Romanticism.” 

American Romanticism. Ed. Jennifer A. Hurley. San Diego: Greenhaven Press, Inc., 

2000. 27-31. Print. 

 

Parenthetical Reference: 

(First-word-in-citation [or two authors‟ names] page) 

 

Examples:  

(Burbank and Moore 28) 

 
 

2.3.12 Article:  Journal 

Work Cited:   

Last Name, First Name. “Article Title.”  Title of Journal Vol.Iss# (Publication Date): 

Pages. Print. 

 

Example: 

Check, Erika, Maureen Lewis, and Roger Bate. "Quest for the Cure." Foreign Policy 

155 (Jul/Aug 2006): 28-36. Print. 

 

Parenthetical Reference: 

(Word(s)-alphabetized Page) 

 

Example:  

(Check, Lewis and Bate 7) 

 

2.3.13 Article:  Magazine 

Work Cited:   

Last Name, First Name. “Article Title.” Title of Magazine Publication Date: Page 

Numbers. Print. 

 

Example: 

Thomas, Evan.  “What Teddy Can Teach Us.”  Newsweek 7 Sep. 2009: 30-3. Print. 

 

Parenthetical Reference: 

(Word(s)-alphabetized Page) 

 

Example:      

(Thomas 32) 
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2.3.14 Article:  Journal from a Database 

Work Cited:   

Last Name, First Name. “Article Title.”  Title of Journal Vol.Iss# (Publication Date): 

Pages. Database Name. Database. Date Accessed. 

 

Example: 

Champion, Laurie.  "Lee's „To Kill a Mockingbird‟." The Explicator 61.4 (Summer 2003): 

234-6. Literature Resource Center. Database. 8 Feb. 2008.  

 

Parenthetical Reference: 

(First-word-in-citation page) 

 

Example:  

(Champion 235) 

 

2.3.15 Article: Magazine from a Database 

Work Cited: 

Last Name, First Name. “Article Title.” Magazine Title Publication Date: Page Numbers. 

Database Name. Database. Date Accessed. 

  

Examples: 

Layden, Tim. “A Portrait of a Child at Play.” Sports Illustrated 13 Nov. 2009: 58. 

ProQuest Platinum. Database. 10 Sep. 2009. 

 

Parenthetical Reference: 

(First-word-in-citation page number if available) 

 

Examples:  

(Layden 58) 

 

Back to top
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2.3.16 Database article (NOT magazine/news/journal article) ex. ABC-CLIO 

Work Cited: 

Last Name, First Name. “Article Title.” Database Name. Publisher, Publication date. 

Database. Date Accessed. 

 

Examples: 

“War with Mexico (overview).” American History. ABC-CLIO, 2008. Database. 6 Mar. 

2008. 

 

 
 

Parenthetical Reference: 

(First-word-in-citation page number if available) 

 

Examples: 

 (“War”) 

 

 

2.3.17 Article: Newspaper  

Work Cited: 

Last Name, First Name. “Article Title.” Newspaper Title Publication Date: Page Number. 

Print. 

  

Examples: 

McCarthy, Michael. “Eating Away the Innings in Baseball‟s Cheap Seats.” USA Today 7 

Mar. 2008:A1+. Print. 

 

Parenthetical Reference: 

(First-word-in-citation page number) 

 

Examples:  

(McCarthy A1) 

 

Back to top
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2.3.18 Article:  Newspaper from Database 

Work Cited: 

Last Name, First Name. “Article Title.” Newspaper Title Publication Date: Page Number. 

Database Name. Database. Date Accessed. 

  

Examples: 

Raine, George. “Virgin Jet to Fly on Biofuel in Test of Cleaner, Cheaper Option.” San 

Francisco Chronicle 5 Feb. 2008. Student Resource Center – Gold. Database. 7 

Mar. 2008. 

 

Parenthetical Reference: 

(First-word-in-citation page number if available) 

 

Examples:  

(Raine) 

 

 

2.3.19 Internet:  Website (page from a website) 

Work Cited:   

Editor, author, or compiler name (if available). “Article Title.”  Name of Website. 

Publisher/Sponsor of Website. Date of Last Update. Web. Date Accessed. <URL>. 

 

Examples: 

West, Larry. “Why is Recycling Not Mandatory in All U.S. Cities?” About.com: 

Environmental Issues. About, Inc. 2009. Web. 10 Sep. 2009. 

<http://environment.about.com>. 

 

“Roller Coaster.” Amusement Park Physics. Annenberg Media. 2009. Web. 30 Sep. 2009. 

<http://www.learner.org>. 

 

Parenthetical Reference: 

(First-word-in-citation) 
 

Examples:  

(West) 

(“Roller”) 

 

Back to top
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2.3.20 Internet:  Website (entire website) 

Work Cited:   

Editor, author, or compiler name (if available). Name of Website.  Publisher/Sponsor of 

Website. Date of last update (if available). Web. Date accessed. <URL>. 

 

Example: 

The Civil War and Reconstruction Era. Rutgers University Libraries.  23 Oct. 2004. Web.  

2 Feb. 2007 <http://andromeda.rutgers.edu >. 

 

Parenthetical Reference: 

(First-word(s)-in-citation) 

 

Example:  

(The Civil War and Reconstruction Era) 

 

2.3.21  Internet:  Journal Article 

Last Name, First Name. “Article Title.”Title of Journal Vol.Iss# (Publication Date): Pages 

(if available). Web. Date Accessed. <URL>. 

 

Example:  

Rosen, Christine. “Virtual Friendship and the New Narcissism.” The New Atlantis 17 

(Summer 2007).  Web. 10 Sep. 2009. <http://www.thenewatlantis.com>. 

 

Parenthetical Reference: 

(First-word-in-citation) 

 

Example:  

(Rosen) 

 

2.3.22 Internet:  Magazine Article 

Work Cited:   

Last Name, First Name. “Article Title.” Title of Magazine Publication Date: Page Numbers 

(if available).  Title of Website. Web. Date Accessed. <URL>. 

 

Example:  

Lavender, William and Mary Lavender.  “Suffragists Storm Over Washington D.C. in 

1917.” American History Oct. 2003.  Web. 8 Feb. 2008. 

<http://www.historynet.com>. 

 

Parenthetical Reference: 

(First-word-in-citation [or two authors‟ names]) 

 

Example: (Lavender and Lavender) 

Back to top 
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2.3.23 Internet:  Newspaper Article 

Work Cited:   

Last Name, First Name. “Article Title.” Title of Newspaper Website Publisher/Sponsor, 

Publication Date. Web. Date Accessed. <URL>. 

 

Example: 

Dean, Cornelia. "Executive on a Mission: Saving the Planet." New York Times New York 

Times, 22 May 2007. Web. 25 May 2009. <http://www.nytimes.com>. 

 

Parenthetical Reference: 

(First-word-in-citation) 

 

Example:  

(Dean) 

 

2.3.24 Internet:  Image from a Website  

Work Cited:   

Artist Last Name, First (if available). “Description” or Title of Image. Date of image. 

Collection/Museum Name (if available). Name of Website. Web. Date Accessed. 

<URL>. 

 

Examples: 

Currin, John. Blond Angel. 2001. Indianapolis Museum of Art. IMA. Web. 28 Sep. 2009. 

<http://www.imamuseum.org>. 

 

Gallay, Charly. “Portrait of Dennis Hopper.” 14 June 2009. Getty Images for CineVegas. 

Life. Web. 30 Sep. 2009. <http://www.life.com>. 

 

Parenthetical Reference: 

(First-word-in-citation) 

 

Examples:  

(Currin) 

(Gallay) 

 

Back to top
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2.3.25 Image from a Database 

Work Cited:   

Artist Last Name, First (if available). Description or Title of Image. Date of image (or n.d. 

for no date). Physical Location of Image (if available). Database Name. Database. 

Date Accessed. 

 

Example:  

Election of 1896.  Library of Congress. n.d. American History. Database. 30 Sep. 2008. 

 

Parenthetical Reference: 

(First-word(s)-in-citation) 

 

Example:  

(Election of 1896) 

 

2.3.26 Image from a book 

Work Cited: 

Artist‟s last name, first name. “Description” or Title of art work in italics. Date of image. 

Collection/Museum Name (if known), city where housed if not already named. Title 

of Book. By Author‟s First Name Last Name. Place of Publication: Publisher, 

Publication date. Page or plate/figure/slide number. Print. 

 

Examples: 

Cole, Thomas. Expulsion from the Garden of Eden. 1827-1828. The Museum of Fine Arts, 

Boston. The Hudson River School: American Landscape Artists. By Bert D. 

Yaeger. New York: Smithmark, 1996. 15. Print. 

 

 
 

Parenthetical Reference: 

(First-word-in-citation page/plate/slide number) 

 

Examples: 

 (Cole 15) 

Back to top
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2.3.27 Sound Recording (music/speech/interview) 

Work Cited: 

Artist‟s Last Name, First Name. “Song Title.” Title of Album. Perf./Cond. Performer or 

Conductor‟s Name (if significant). Record Label, Date. Format/File Type. 

  

Examples: 

King, B.B. “The Thrill is Gone.” The Best of B.B. King: The Millennium Collection. MCA 

Records, 1999. CD.  

 

Jones, Norah. “Light as a Feather.” The Fall. Blue Note Records, 2009. MP3 file. 

 

Parenthetical Reference: 

(First-word-in-citation) 

 

Example 

(King) 

(Jones) 

 

 

 

2.3.28 Sound Recording(music/speech/interview) (from website) 

Work Cited: 

Artist‟s Last Name, First Name. “Song Title.” Album Title. Record Label, Date. Title of 

Website. Web. Date Accessed. <URL>. 

  

Examples: 

The Beach Boys. “California Girls.” Mp3.com. Web. 3 Nov. 2010. 

<http://www.mp3.com>. 

 

CBS ABC. “News Death of FDR.” 12 Apr. 1945. The Internet Archive. Web. 3 Nov. 2010. 

<http://ww.archive.org>. 

 

Parenthetical Reference: 

(First-word-in-citation) 

 

Examples:  

(The Beach Boys) 

(CBS ABC) 

 

Back to top 
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2.3.29 Sound Recording (music/speech/interview) (from database) 

Work Cited: 

Artist‟s Last Name, First Name. “Song Title.” Title of Album (if applicable). Date of 

Recording. Audio. Database Name. Database. Date Accessed. 

  

Examples: 

Mozart, Wolfgang. “Symphony No. 40. First Movement.” The Hutchinson Dictionary of 

Music. Audio. 2000. eLibrary. Database. 3 Nov. 2010. 

 

Parenthetical Reference: 

(First-word-in-citation) 

 

Examples:  

(Mozart) 

   

 

2.3.30  Video Clip from a Database 

“Description” or Title of video clip. Director/Creator‟s Names. Date of clip. Database 

Name. Database. Date Accessed. 

 

Example: 

“Lyndon B. Johnson Explains His Vietnam War Policy.” 2009. US at War. Database. 23 

Sep. 2009.  

 

Parenthetical Reference: 

(First-word(s)-in-citation) 

 

Example:  

(“Lyndon”) 

Back to top
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2.3.31  Video Clip Online (YouTube and other websites) 

Work Cited:   

“Description” or Title of video clip. Director/Creator‟s Name. Date of clip. Title of 

Website. Web. Date Accessed. <URL>. 

 

Example: 

Evolution of Dance. Judson Laipply. 6 Apr. 2006. YouTube. Web. 23 Sep. 2009. 

<http://www.youtube.com>.   

 

Parenthetical Reference: 

(First-word(s)-in-citation) 

 

Example:  

(Evolution) 

 

2.3.32  Personal Interview 

Work Cited:   

Interviewee‟s last name, first name.  Personal Interview. Date of interview. 

 

Example: 

Scalia, Antonin. Personal Interview.  16 June 2009. 

 

Parenthetical Reference: 

(First-word(s)-in-citation) 

 

Example:  

(Scalia) 

Back to top
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2.3.33  Oral Presentations (e.g. Speeches, Lectures) 

Work Cited:   

Speaker‟s last name, first name.  “Title of Speech (if any).”  Name of meeting/organization.  

Location of speech. Dates of speech.  Type of presentation. 

 

The types of presentations are Address, Lecture, Reading, Keynote Address, Guest 

Lecture. 

 

Example: 

Stein, Bob.  “Computers and Writing Conference.”  Purdue University.  Union Club Hotel, 

West Lafayette, IN.  23 May 2003.  Keynote Address. 

 

Parenthetical Reference: 

(First-word(s)-in-citation) 

 

Example:  

(Stein) 

 

 

2.3.34  Blog:  Entire Blog 

Work Cited:   

Author‟s Last Name, First Name.  Title of Blog.  Sponsor/Publisher.  Date Last Updated.  

Web. Date Accessed. <URL>. 

 

Example: 

Mayer, Caroline.  The Checkout.  Washington Post, 27 April. 2006.  Web. 19 Jan. 2009. 

<http://voices.washingtonpost.com/thecheckout/>. 

 

Parenthetical Reference: 

(First-word(s)-in-citation) 

 

Example:  

(Mayer) 

 

Back to top
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2.3.35  Blog:  Entry or Comment 

Work Cited:   

Author‟s Last Name, First Name.  “Title of Blog Entry.”  Title of Blog.  Sponsor/Publisher.  

Date Last Updated. Web. Date Accessed <URL> 

 

Example: 

Mayer, Caroline.  “Some Surprising Findings about Identity Theft.” The Checkout.  

Washington Post, 28 Feb. 2006.  Web.  19 Jan. 2009 

<http://voices.washingtonpost.com/thecheckout/>. 

 

If the entry or comment has no title, use the label “Weblog entry” or “Weblog 

comment” in place of the “Title of the Blog Entry.” 

 

Example: 

Burdick, Dennis.  Weblog comment.  The Checkout.  Washington Post, 29 Feb. 2006.  

Web. 19 Jan. 2009 <http://voices.washingtonpost.com/thecheckout/>. 

 

 

Parenthetical Reference: 

(First-word(s)-in-citation) 

 

Example:  

(Mayer) 

(Burdick) 

 

 

2.3.36 E-mail 

Work Cited:   

First-word-in-citation, First Name. “Re:  Subject Line.”  Message to author‟s name.  Date 

of message.  E-mail. 

 

Example: 

Smith, Andrew.  “Re: Modernist Literature.”  Message to Ralph Alexander.  1 Mar. 2010.  

E-mail. 

 

Parenthetical Reference: 

(First-word(s)-in-citation) 

 

Example:  

(Smith) 

 

Back to top 
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Appendix A 

Formatting your paper in Microsoft Word 2003 

 

[Appendix B provides information on formatting in Word 2007.] 

 

Please see the documentation for your own word-processing program, or bring your paper to 

school as a text file and format it using Word.  Do not expect your teachers to format your papers 

to meet standards. 

 

MARGINS: 

1. Open your document. 

2. Click File/Page Setup. 

3. Click on the Margins tab. 

4. Adjust all margins to 1”. 

5. Click on the paper tab. 

6. Check that the paper is 8 ½” by 11”.  Adjust as needed. 

 

DOUBLE-SPACE: 

1. Open your document. 

2. If you have already typed some of the paper, Click Edit/Select All. 

3. Click Format/Paragraph. 

4. In the Line Spacing box, pull the dropdown menus and select “Double.” 

5. REMEMBER:  You will need to change back to single-space for your Works 

Cited/Bibliography page. 
 

HEADER: 

1. Open your document. 

2. Click View/Header and Footer. 

3. Hit TAB two times to get to right justification. 

4. Type your last name. 

5. Hit SPACE. 

6. In the Header and Footer dialogue box, click the sign “#.”  This will automatically number 

your pages sequentially as required. 

7. NOTE:  The heading of the paper should be in the body on the first page.  DO NOT PUT 

IT IN THE HEADER OR IT WILL APPEAR ON EVERY PAGE. 

8. Click Close or in the body of the paper close the header box.  The header will appear on the 

screen. 
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WORKS CITED PAGE: 

Remember, we suggest you create a draft of a Works Cited page before beginning your paper.   

1. Open your document. 

2. Format margins as noted above, but make the spacing single-space. 

3. Center the title “Works Cited” on the first line 1” from the top of the page. 

4. Left justify the paper. 

5. If you cannot see a ruler at the top of the page, click View/Ruler. 

6. Run the mouse cursor along the bottom of the ruler until you see “Hanging Indent.”  Move 

slowly. 

 
7. Click and drag the cursor to pull the lower margin to ½”.  The first line of each section will 

be against the left margin and all subsequent lines will be indented ½”. 

8. Alternatively, when you are ready to draft the Works Cited page, click Format/Paragraph.  

Under Indentation, click the drag-down menu for Special to Hanging and specify .5” for 

the indent. 

REMEMBER:  The rest of your paper must have regular paragraph indentions, so be sure to 

change the format for the Works Cited page. 

 

 

Back to top
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Appendix B 

Formatting your paper in Microsoft Word 2007 

 

 

Since Microsoft Word 2007 is available on all Fairfax County Public School computers, this 

appendix provides information about the formatting required for academic papers using that 

software.  Do not expect your teachers to format your papers to meet standards. 

[Appendix A provides information on formatting in Word 2003.] 

 

MARGINS: 

1. Open your document. 

2. Click the Page Layout tab at the top. 

3. Click the Margins tab. 

4. Click on the Normal margins settings. 

 

CHANGE FONT:   

[Word 2007 defaults to Calibri 11.  You must change the font 

to meet requirements.) 

1. Open your document.   

2. If you have already begun typing, select all of the text. 

3. On the Home tab, use the pull-down menu to select Times New Roman font. 

4. Use the pull-down menu to select 12 point. 

5. The font selection on your Home page should now include this:   

 

CORRECT EXTRA SPACING BETWEEN PARAGRAPHS: 

1. Open your document. 

2. From the Home menu, click on the arrow next to Paragraph.  

3. On the Indents and Spacing tab in the Spacing section, be sure that the Before and After 

settings are 0 (zero). 

 

DOUBLE-SPACE: 

1. Open your document. 

2. Highlight the portion of your essay that is not already double-spaced.  Remember: Works 

Cited will NOT be double-spaced. 
3. On the Home page, click arrow on the spacing icon. 

4. Click 2.0. 

5. Your document should change to double-space 

throughout. 

 

HEADER (Put last name and page number ONLY):  

1. Open your document.  

2. Click the Insert tab at the top. 

3. Go to Page Number and select Top of Page/Plan 

Number 3.  

4. Insert your cursor just before the number and type your 

last name and a space. 

5. Click in the body of the paper to close the header menu.   

The header will appear on your screen. 

Return to the Home Menu and change the font to Times 

New Roman, 12 point. 
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HEADING: 

1. On the first page of your document, complete the Heading as prescribed in the formatting 

sheet. 

2. If you have completed all the changes above, your heading and title will look like this: 

 

 

WORKS CITED PAGE: 

Remember, we suggest you create a draft of a Works Cited page BEFORE beginning your paper. 

1. Open your document. 

2. Format Margins and Extra Spacing as noted above, but make the spacing single-space. 

3. Center the title “Works Cited” on the first line one-inch from the top of the page. 

4. Left justify the rest of the page. 

5. If you cannot see a ruler at the top of the page, click the View tab at the top, and put a 

check in the box next to Ruler.  

6. Run the mouse cursor along the bottom of the ruler until you see  

“Hanging Indent.” Move slowly.   

7. Click and drag the cursor to pull the lower margin to ½”.  The first line of each section will 

be against the left margin and all subsequent lines will be indented ½”. 

8. Alternatively, when you are ready to draft the Works Cited page, go to the Home menu, 

click the arrow next to Paragraph as above.  Under Indentation, click the drag-down menu 

for Special to Hanging and specify .5” for the indent. 

 

REMEMBER:  The rest of your paper must have regular paragraph indentions, so be 

sure to change the format for the Works Cited page. 

 

Back to top
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Appendix C 

Adding Symbols 

 

Since Microsoft Word 2007 is available on all Fairfax County Public School computers, this 

appendix provides information about the formatting symbols in Word 2007. 

 

Symbols, not words, are required in science and other papers. 

 

Please follow these instructions for scientific notation to show the symbols: 

1. Click on the Insert tab at the top of the document. 

2. On the far right of the screen, click on  

3. A screen like this will appear: 

 

 

 

 

 

 

 

 

 

 

 

4. Click inside the screen on the symbol you want to use.   

5. If you don‟t see what you need, click on More Symbols for a wide variety of symbols and 

special characters. 

6. The screen will disappear after your symbol is inserted. 

Back to top
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Appendix D 

Scientific Notation 

 

Since Microsoft Word 2007 is available on all Fairfax County Public School computers, this 

appendix provides information about the formatting scientific notation in Word 2007. 

 

Scientific notation is a standardized method for expressing and working with very large or very 

small numbers.  It consists of three parts:  The coefficient, the base, and the exponent as in  

  This format is required for science and many math academic papers. 

   

Please follow these instructions for scientific notation: 

 

7. Click on the insert tab at the top of the document. 

8. On the far right of the screen, click on  

9. A screen like this will appear: 

 

 

10. Click inside the screen and type in your coefficient. 

 

11. Space and then click on the multiplication button          

at the top of the Design menu. 

 

12. Space and then click on superscript portion of the Script button: 

 

 

13. Click into the larger section to type the base (always 10) and into the smaller section for the 

exponent . 

 

14. Your number will meet the requirements for scientific notation:   

 

Back to top
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Appendix E 

Style Guide Checklist 

Ask yourself the following questions before submitting an academic paper. 

 

The paper: 
GENERAL FORMATTING 

 1. Is on one side of paper? 

 2. Is double-spaced? 

 3. Uses Times New Roman 12-point font? 

 4. Has a header in format Last Name #? 

 5. Has heading & title as required? 

 

Joyce Smith 

 

Jones 

 

Period 3 

 

23 March 2009 

 

Title in Regular Font 

 6. Is only double-spaced between paragraphs? 

 7. Has one-inch margins all around? 

 8. Has paragraphs indented ½”? 

WORKS CITED/BIBLIOGRAPHY FORMATTING 

 1. Is on a separate page but numbered sequentially? 

 2. Is single-spaced with double space between entries? 

 3. Has title centered in regular font:  Works Cited OR Bibliography 

 4. Uses hanging indent? 

 5. Lists Author‟s Last Name first or as directed on sample? 

 6. Is in alphabetical order? 

 7. WORKS CITED:  Uses each source cited in paper? 

PARENTHETICAL CITATIONS 

 1. Has all citations using first word (or words if repeated on Works Cited)? 

 2. Has word(s) in citations italicized or in quotations marks as on Works 

Cited page?  

 3. Has all citations using parentheses outside the quotation, but inside the 

period? 

 4. Correctly cites all quotations and opinions? 

PAPER CONTENT 

 1. Contains paragraphs with topic and clincher sentences? 

 2. Contains paragraphs with sufficient evidence to prove the assertion? 

 3. When writing about literature, uses present tense? 

 4. In any case, maintains consistent tense (past, present, future)? 

 5. Maintains consistent point of view (e.g. first, second, or third person)? 

 6. Uses appropriate and logical transitions? 

 7. Is free of grammar errors, especially run-ons and fragments. 

Back to top 


